
Renishaw InVia Quick Operation Summary—October 2018 
This document is frequently updated—if you feel information should be added, please indicate that to the 
facility manager (currently Philip Carubia, pmc228@cornell.edu, B57 Bard Hall, office and cell: 607-255-
6757).  All procedures are subject to change. 

If you have any questions about the operation of the instrument, do not take any risks—first contact the 
facility manager: he has his cell phone with him at all times. 

Reservations and Enabling on Coral: The Renishaw InVia Raman microscope is on the CCMR Coral 
equipment reservation and enabling system.  Users are allowed to reserve the instrument for as much time as 
they need.  However users who reserve time and do not cancel it in advance will be charged; abuse of the 
reservation system can result in suspension of CCMR facility privileges.  You can access Coral either from your 
laptop or from the Coral computer in Bard SB30, to which you will be given access. 

Safety: This instrument uses Class IIIb lasers, so please be alert to the safety issues you learned in the EH&S 
laser safety course.  Use of laser safety eyewear is not required except in the case of the operation of the 532 nm 
laser. 

Logbook: Record the date, your name, and hours of usage.  Comment on problems.   

Keeping lab orderly:  Please dispose of any glass slides that you use into the glass dispsal container that is kept 
on the floor near the base of the system.  Also dispose of wipes, tape, etc. when you are done with them. 

Steps to run system: 

1) Enable the instrument on Coral. 

2) Verify that main power is on and that the computer is on.  Normally these are left on. 

If the main power is off, check with facility manager before turning the system on.  The computer can be 
rebooted if needed. If the Windows logon dialog comes up, log on as “CCMR-User” with password “ccmruser”. 

Start the Wire 4.2 software.  Pick “Reference un-referenced motors only” if the Motor Reference Options dialog 
box comes up.  

3) Verify that the shutter is closed.  

4) Turn on the lasers you wish to use if they are not already on.   You should wait 10 minutes if you need very 

stable power or frequency; for a quick measurement you can begin right away.  

785 nm laser: This laser is behind the optical microscope on the left hand side.  DO NOT WALK BEHIND 

THE OPTICAL BENCH TO TURN ON THE MICROSCOPE!  To turn on the 785 nm laser, first check the two 

rockers switches on the side of the spectrometer that operate the safety interlocks for the 785 nm and 1064 nm 

lasers.  Make sure that the safety interlock for the 1064 nm laser is off—this will ensure that the 1064 nm laser 

is not powered on.  Turn on the rocker switch for the safety interlock for the 785 nm laser. Then you need to 

find the small round black push-button switch at the back of the 785 nm laser housing. The laser housing is 

made of shiny blue metal. Push MOMENTARILY on the push button to turn the laser on.  A green light will go 

on at the back of the laser housing near the push-button.  DO NOT try to adjust the black metal shielding or turn 

the key on the laser.  You also need to push this button when you turn the laser off at the end of your session—

the green light will go off.  YOU SHOULD ALSO TURN OFF THE SAFETY INTERLOCK SWITCH ON 

THE SIDE OF THE SPECTROMETER WHEN YOU ARE THROUGH AND BEFORE TURNING ON THE 

1064 nm LASER.  

1064 nm laser: This laser is behind the optical microscope on the right hand side.  DO NOT WALK BEHIND 

THE OPTICAL BENCH TO TURN ON THE MICROSCOPE!  To turn on the 1064 nm nm laser, first check 

the two rockers switches on the side of the spectrometer that operate the safety interlocks for the 785 nm and 

1064 nm lasers.  Make sure that the safety interlock for the 785 nm laser is off—this will ensure that the 785 nm 

laser is not powered on.  Turn on the rocker switch for the safety interlock for the 1064 nm laser.  Then you 

need to find the small round black push-button switch at the back of the1064 nm nm laser housing. The laser 

housing is made of shiny blue metal. Push MOMENTARILY on the push button to turn the laser on.  A green 



light will go on at the back of the laser housing near the push-button.  DO NOT try to adjust the black metal 

shielding or turn the key on the laser.  You also need to push this button when you turn the laser off at the end 

of your session—the green light will go off.  YOU SHOULD ALSO TURN OFF THE SAFETY INTERLOCK 

SWITCH ON THE SIDE OF THE SPECTROMETER WHEN YOU ARE THROUGH AND BEFORE 

TURNING ON THE 785 nm LASER.  

488 nm and 532 nm lasers: The 488 nm laser (which has the blue fiber optic connected to the laser output) has 

a key on the power supply. It must be turned to “Start” and held there momentarily for the laser to be started.  

Do not adjust the power knob on the 488 nm laser power supply!  There is a manual shutter on the 488, but it is 

left open so as not to disturb the fiber optics.  The procedure for turning on the 532 nm laser is at the end of this 

document—YOU MUST BE RECEIVE A SEPARATE TRAINING SESSION FOR THE 532 nm LASER 

DUE TO SAFETY CONCERNS. 

Currently the 785 nm and 1064 nm lasers are safety interlocked but the 488 nm and 532 nm lasers are not. If 
you open the spectrometer door with either the 785 nm or 1064 nm laser selected and the shutter open, the laser 
will power down.  For the other lasers, you need to make sure the shutter is closed when you open the 
spectrometer door with any of the lasers on.  So you must be careful to check that the shutter is closed before 
opening the spectrometer door (see step 8). 

5) Set the Leica microscope up for white light imaging.  Put in the 5x objective.  Verify that the upper selection 
wheel is set to 2 and the lower selection wheel is set to 1.  The power on the white light illuminator can be 
turned up to whatever level is appropriate for you sample (this is the wheel at the bottom left of the microscope 
body).  The illuminator is always left on and should be turned down to its lowest setting at the end of your 
session. 

Because of the different lighting in the room, light from the overhead fluorescents can enter through the eyepieces 
and be seen in the imaging camera when you are not looking through the eyepieces. To eliminate this problem, 
there is a rod on the left hand side of the trinocular with three positions—when it is pulled all the way out, then 
the eyepieces are blocked and the light from the sample only goes to the camera.  It should be left in the middle 
position for use of both the eyepieces and camera. When using white light imaging, pulling the rod out is optional.  
However you should pull the rod out when aligning the system with the lasers and taking Raman spectra.  You 
should also turn off the room lights for sensitive measurements. 

Video Camera: The video camera should be set to not have auto-gain.  This means that in white light you may 

need to adjust the white light intensity using the dial on the lower left of the microscope base to get the best white 

light image. In normal operation, you should not need to change the settings for the microscope camera.  If for 

some reason you need to increase the gain on the camera (or if the computer has not opened the video camera) 

follow the instructions below.   

Sliding the mouse over the sprocket in the field of view of the video window allows you to access the video 

settings using sliders below the sprocket. However it is actually easier to click on the sprocket itself—this opens 

up a window that allows you to adjust the settings with more finesse than doing it directly with the sliders under 

the sprocket. So if the laser spot appears too bright or your white light images are too dim, you can make 

adjustments easily.  However remember that random clicking in the video field of view causes the x-y stage to 

put the center of the video image where you click, so be careful using this feature. 

It is also possible to restore the camera to its default settings in case you have problems with the previous user 

altering the video settings.  To do this, right click when the mouse is in the field of view of the video camera, 

then choose Video Properties, then VideoSource tab, then choose the button at the lower left labeled “Reset 

Properties.”  

IF WIRE SOFTWARE DOES NOT OPEN THE VIDEO CAMERA: UNDER VIEW, CHOOSE LIVE VIDEO.  

6) Place the Si reference sample underneath the objective and focus on the Si using white light.  Rotate in 

increasingly higher power objectives until you have the 100x in place.  You can use the regular 50x objective but 

because of some absorption due to coatings on the objective, the signal strength with the 50x will be lower than 

with the 100x, most noticeably with the 488 nm laser.  If you are imaging powders, liquids, foils, or fibers, you 

should use the 50x long working distance objective (which is a different objective from the regular 50x objective) 



and requires a short training--do not use the 50x long working distance objective without first getting this training 

from the facility manager. 

Remember that rotating the coarse and fine focus knobs counterclockwise (towards the 
user) moves the microscope stage down. 

7) For Raman imaging, switch the upper mirror selection wheel to 1 and the lower mirror selection wheel to 2.  
Pull out the camera selection rod on the upper left side of the microscope trinocular to the fully out position, 
which ensures that no light gets to the eyepieces.  Make sure the magnification of the objective you are going to 
use is entered into the software through the pull-down menu (100x, 50x, etc).   

8) DO NOT LOOK THROUGH THE EYEPIECE FROM THIS POINT ONWARD—USE THE CCD 
CAMERA IMAGE ON THE SOFTWARE! 

9) The manual adjustment of hardware you need make are as follows: 

a) the three lenses in the spectrometer: The lenses that need changing when you go to a different laser are the 
A2,B2,C2 (for 488 and 532 nm), A1,B1,C1 (for 785 nm) lenses and a separate lens set for 1064 nm (these lenses 
are currently unlabeled). 

b) the gratings in the spectrometer if you intend to use the 600 l/mm visible grating or the 600 l/mm infrared 
grating for 1064 nm operation.   A separate training session is required if you plan on using the either of the 600 
l/mm gratings. 

c) The detector mirror on the detector arm. There are two detectors: the InGaAs detector for the 1064 nm laser 
which is pointing upward and the Si detector for all the other lasers.  You must manually move a mirror to choose 
which detector to use.  There is a cartoon on the detector arm showing where to position the wheel that moves the 
mirror.  You should pick position 3 for the Si detector (labeled Renishaw Streamline CCD)) and position 1 
(labeled “Top Detector Position”) for the 1064 nm laser.  When rotating the wheel, it is better not to hold onto 
the small protruding finger attached to the wheel but rather grab the wheel itself at its diameter—you will sense 
a click when the wheel is in the correct position (note that the finger actually does not quite align with where the 
cartoon shows it should be for the different positions).  Users of the 1064 will certainly forget to rotate the wheel 
back to the regular position, so if you have no counts, check the wheel! 

d) Except for the 532 nm edge and 1064n nm edge Rayleigh filters,  the Rayleigh filters are on a motorized 
rotating panel and will be put in place automatically when you choose the laser/filter combination using the 
menus along the bottom of the main software panel (there is an icon that looks like a laser spot).  Below are the 
choices: 

785 nm edge 

488 nm edge 

1064 nm edge 

785 nm Fiber Optic Launch 

488 nm edge Linefocus 

785 nm edge Linefocus 

488 nm Fiber Optic Launch 

532 nm edge 

532 nm edge Linefocus 

532 nm ULF 

For the standard measurements using one of the four lasers, one would choose from “785 nm edge,”  “488 nm 
edge,” “1064 nm edge,” or “532 nm edge.”  For using the 532 nm ultra-low frequency filter, choose “532 nm 
ULF.”  A separate training session is required for the 532 nm ULF.   

The 532 nm edge filter and the 1064 nm edge filters need to be installed manually.  WHEN CHANGING THESE 
FILTERS IT IS OF THE UTMOST IMPORTANCE THAT YOU DO NOT DISTURB THE ULF FILTER IN 
ANYWAY—YOU SHOULD BE CAREFUL TO NOT EVEN LET THE FILTERS TOUCH THE ULF AS YOU 
REMOVE AND INSTALL THEM. 

To do the manual installation, first choose the filter in software.  Once the filter is chosen, to install the 532 nm 
edge filter, remove the 488 nm edge filter by first unscrewing the long silver-colored bolt that attaches it and then 
grasping the u-shaped handle on the filter body and gently pulling it off the mounting rod. Then in the storage 



box marked “Rayleigh filters” you will find the 532 nm edge—it is not at all convenient to pick up, so you will 
need to grasp the cube in which the filters are mounted carefully with your fingers and slide it onto the mounting 
rod.  The magnets will hold it in place—you should not use the silver-colored bolt.  To install the 1064 nm filter, 
choose that filter in software.  Once the filter is chosen, to install the 1064 nm edge filter, remove the 785 nm 
edge filter by first unscrewing the long silver-colored bolt that attaches it and then grasping the u-shaped handle 
on the filter body and gently pulling it off the mounting rod. Then in the storage box marked “Rayleigh filters” 
you will find the 1064 nm edge filter—it has the same kind of u-shaped handle as the 488 and 785 nm filters with 
which to grasp it.  Once you have slid it onto the mounting rod, use the silver-colored bolt to fix it in place.  When 
you are done with your measurements, you should remove the filter you installed and replace the one that you 
removed.   

10) You also need to pick a grating in software.  For 488 excitation, pick the 2400 l/mm grating using the pull 
down menu at the bottom of the main software panel.  For 785 excitation, pick the 1200 l/mm grating using the 
pull down menu.  For 532 nm ULF filter operation, choose the 2400 l/mm grating.  For high-speed imaging with 
the 532 nm laser, you can use either the 2400 l/mm grating or manually replace that grating with a 600 l/mm 
grating (see the facility manager for additional training on changing the filters manually, high-speed imaging and 
using the ULF).  For 1064 nm operation, you need to pick the 600 l/mm NIR grating. 

In setting up a measurement, you must also choose from one of two detectors in software:  “Renishaw CCD 
Camera” or “Andor 018984.” The Andor is only to be used for the 1064 nm laser, so make sure that the 
Renishaw is chosen for all other measurements. 

11) Open the shutter.  If you get an error box “Warning: Interlock relays are disabled” check that the spectrometer 
door is locked tight.  Then hit “Retry” in the error box.   

12) Using the slider bar in software for the neutral density filters, bring the laser power to a level where the 

video is not saturating and the laser spot is as small as possible without being too dim to see.  Making sure you 

have picked the SLOWEST speed on the trackball control. use the fine focus ring on the microscope track ball 

to sharpen the image of the laser.   Adjust the fine focus ring in small steps or you risk crashing the objective 

into the sample.   

13) Under the “Measurement” pull-down menu on the top menu bar, pick “New Spectral Acquisition”.  Take a 

static spectrum at the wavelength you want to use.  The counts for the 488 nm laser using the 2400 l/mm grating 

at 1 sec exposure and 100% power should be approximately 7,000 counts.  The counts for the 785 nm laser using 

the 1200 l/mm grating at 1 sec exposure and 10% power should be approximately 4,000 counts.   The counts for 

the 532 nm laser at 40 mW using the 532 nm edge filter and the 2400 l/mm grating at 1 sec exposure and 100% 

power should be approximately 25,000 counts.   

If you are not getting these counts, you will need to first manually align the laser beam position to be at the center 

of the crosshair box in the video image.  This is done with the “Manual Beamsteer” option in the pull-down menu 

on the top menu bar under “Tools”. 

When using Manual Beamsteer,  Only use the left set of arrows when steering the beam manually.   

After centering the beam, use AutoAlign (goto  “Tools>AutoAlign>Align” ) for the CCD  and the slits. Do no 

use AutoAlign for the laser position—use it only for the CCD and slits after you have manually aligned the laser 

position. 

As indicated above, before using Manual Beamsteer, set up and run a measurement.  Anytime you use Manual 

Beamsteer, you should then do Align CCD Area followed by Auto Align Slit (Optimise).   

Important Warning on AutoAlign CCD:  the AutoAlign CCD will give you “Initial” and “Final” values of the 

pixels on the CCD where the system will collect the Raman scattered light.  These pixels should be within the 

range from 20 to 60 for 488 nm, 20 to 60 for 785 nm, 20 to 60 for 532 nm edge. Sometimes the routine makes 

an error and gives as a final value a range of pixels that is far from the initial.  If this happens, do not accept the 

results—revert and just use the initial values. 

If after doing these things, the counts are less than 50% of the expected values, please make a note in the 

logbook.   



14) From the Tools menu, pick “Calibration>Quick Calibration” to ensure that the spectral calibration of the 
instrument is correct. 

15) Rotate out 100x and place your sample onto the microscope stage.  Proceed with your sample measurement.  
More information on setting up measurements is available in the photocopied Renishaw documents and via the 
Help files of the Wire software. 

16) Shutdown: Put the 5x objective into place, lower the microscope stage, remove your sample, put the mirror 
selection wheels into the position for White Light imaging, turn down the intensity of the microscope halogen 
illuminator with the dial at the lower left of the microscope base, exit the Wire software, turn off whatever laser 
you are using, exit Coral. 

Operating Tips: 
When you are setting up a new measurement and are in the “Acquisition” tab, there is an option “Restore 

instrument state on completion.”  Check this option.  This will bring the power to whatever level you have set it 

to manually after the measurement is done.  You can also choose the option of closing the shutter after the 

measurement to avoid overexposing light-sensitive samples. 

The origin of the mapping stage can be reset to zero  by picking “Choose Origin” under the “Live Video” pull 

down menu along the top menu bar. 

Be careful about making sure that confocality is set to “Standard” and not to “High” in the Range tab in the 

Measurement Setup window. 

We have changed the sign convention for the z-stage position:  more negative now means deeper into sample 

(same as moving stage up) 

Turning the 532 nm laser on 
Make sure the 532 nm laser cooling fan  is turned on at the terminal strip (you should be able to hear the fan, 
but do not reach in to check the fan at the laser because you may disturb the optics). 

Put on laser safety goggles. 

Start the laser software on computer; the software is called “Cobolt Monitor” 

Pull down the File menu and choose “Connect” 

Click on the radio button “Set Power” 

Set laser power level in software to 40 mW. 

Click on the “Restart” button in the software. 

Turn on the power key to laser. 

The message box on the right hand side of the Cobolt Monitor software window should quickly highlight in  
blue the “Warming Up” message.  If it is stuck on the “Waiting for Key” message, turn the key off, wait 20 
seconds, hit “Restart” and turn the key back on. 

Wait until the message box shows “Completed” highlighted in blue.  

Remove safety goggles. 

You can adjust the laser power with the software from that point on.  If you adjust the power above 100 mW, 
put the laser goggles on whenever the shutter is open. 

Turning off 532 nm laser. 

Turn the power key on the laser off. 

Turn down the power in the software. 

Disconnect the laser from the Cobolt software. 

Wait 2 minutes and turn off the 532 nm laser cooling fan at the terminal strip. 

Exit the laser software. 

Installing Wire 4.1 on your computer 
You can get Wire 4.1 from the desktop on the new computer—the folder is called “Wire 4.1 CD” (it is also 
available to Cornell users as a zipped file at https://cornell.box.com/s/gxy4pkeo2od1bdukdx3d).  Copy this 
folder to your memory stick and follow the instructions in the file  “Wire Install Notes” that is in the “Wire 4.1 



CD” folder. Be especially careful to copy the “Wire 4.1 CD” to your desktop—do not try to install from the 
memory stick directly.  You do not need to uninstall Wire 3.4 if you had it running on your computer. 

Storing Data 
ALL data should be stored on the Users folder on the D: drive in a folder with your netID as its name—there is 
a shortcut on the desktop to this Users folder.  I have transferred all user folders dating from 2013 and later from 
the old User folder to the new User folder. If you need to get to your data or measurement settings from the old 
computer, let me know.  

 No longer will any data files on the desktop or on the system drive be tolerated—they will be deleted.  You 

must put your data onto the Users folder on the D: drive. 

 

Data Formats 

Renishaw now uses a new data format (wdf) instead of wxd.  This format cannot be read by Wire 3.4.  However 

all the data that you took with Wire 3.4 as wxd files can be read by Wire 4.1.  So if you want to view the data 

you take with Wire 4.1, you can either save your data as txt files, in which case you can use Wire 3.4 or Wire 

4.1 or other programs to view the data, or you need to install Wire 4.1 on a Windows 7 machine to view the wdf 

files.   According to Renishaw, Wire 4.1 is not going to function with XP or with Windows 8 but some users 

have been able to install Wire 4.1 on Windows 8 machines, so you can give it a try. 

 

Identifying Peaks in Spectra 

The  KnowItAll spectrum database and analysis software is available both online and as client software that you 

can download. This is not trial software—Cornell has a full license for both the online and client versions.  We 

welcome any comments you have on using the software—we can pass those on to BioRad. You can register for 

a permanent license by providing your name and Cornell email address at: 

http://www.knowitallu.com/KnowItAll_U_Getting_Started/  

When you do this, you will be directed to a site where you can download the client software.  You will also 

receive an email with a registration code.  For those of you who downloaded the software already, it is 

recommended that you not reinstall the software—instead update your registration code at License > Change 

License in KnowItAll.  

Note that the client version of the software runs under XP, Windows 7 and Windows 8 but not the Mac.  For 

those without a Windows emulator on their Mac, the online version (link below) provides some of the features 

of the client software. 

Renishaw .wxd (old Renishaw file format) and Renishaw .wdf (new Renishaw file format) files can be read by 

the client software and the online version of the software. 

The online version of the software is available at: 

http://resolver.library.cornell.edu/misc/7019280 

 There are several online movies explaining the features of KnowItAll U at 

 http://www.training.knowitall.com/default.asp?utm_source=knowitall.informatics.bio-

rad.com&utm_medium=referral&utm_campaign=Demo_Movies&utm_content=KIAU_Edition 

 The quick-start guide for KnowItAll is available at: 

 http://www.bio-rad.com/webroot/web/pdf/spectroscopy/global/english/literature/docs/280076-

KnowItAll_Quick_Start_Guide_E 

http://www.knowitallu.com/KnowItAll_U_Getting_Started/
http://resolver.library.cornell.edu/misc/7019280
http://www.training.knowitall.com/default.asp?utm_source=knowitall.informatics.bio-rad.com&utm_medium=referral&utm_campaign=Demo_Movies&utm_content=KIAU_Edition
http://www.training.knowitall.com/default.asp?utm_source=knowitall.informatics.bio-rad.com&utm_medium=referral&utm_campaign=Demo_Movies&utm_content=KIAU_Edition
http://www.bio-rad.com/webroot/web/pdf/spectroscopy/global/english/literature/docs/280076-KnowItAll_Quick_Start_Guide_English.pdf
http://www.bio-rad.com/webroot/web/pdf/spectroscopy/global/english/literature/docs/280076-KnowItAll_Quick_Start_Guide_English.pdf

